
How to Use FamilySearcher 
 

IMPORTANT:  BEFORE USING FAMILYSEARCHER YOU MUST FIRST CREATE A 
PAF FILE WITH THE THREE OR FOUR GENERATION INFORMATION THAT YOU 
HAVE BEEN GIVEN BY THE ONE YOU ARE PREPARING THE FAMILY HISTORY 
PACKET FOR.  YOU WILL ULTIMATELYADD INFORMATION FROM YOUR RESEARCH 
TO THIS FILE TO CREATE THE PEDIGREE CHART AND FAMILY GROUP SHEETS 
THAT YOU WILL INCLUDE IN YOUR PACKET.  BUT IT IS NECESSARY THAT THIS 
FILE BE CREATED WITH THE INITIAL FAMILY HISTORY INFORMATION IN ORDER 
FOR YOU TO BEGIN YOUR INTERNET RESEARCH USING FAMILYSEARCH. 
 
 
 
 
 
 
 

S
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The following is a brief explanation of how to use FamilySearcher in researching key family 
history websites.  See Appendix I at the end of this document for extensive details.  Also click
“Help” on the FamilySearcher menu for comprehensive information.
tep 1 

Create a GEDCOM file from the PAF file you have prepared.  On the PAF tool bar, 
click “File.”  Then click “Export.”  Follow the instructions to create a GEDCOM file 
from your PAF file.  You will “Export” it to the same folder your PAF file is in.  If you 
need help, click “Help” on the PAF toolbar and read the instructions for creating 
GEDCOM files.  Your PAF file will need to be in GEDCOM format in order for 
FamilySearcher to use it. 

tep 2 

Open the FamilySearcher 
program.  It is up to you 
whether or not you fill 
out the “Sign on” sheet 
that pops up.  Close that 
sheet before proceeding. 

 



Step 3 

Locate your PAF folder 
and open the GEDCOM 
file you have created.  
This will load that file 
into FamilySearcher 

 

Step 4 

Become familiar with the 
FamilySearcher toolbar 
and what each icon does. 
Hold the mouse on an 
icon to see what it 
represents.  Experiment! 

Step 5 

Highlight one of the last 
generation (3rd or 4th) 
names. NOTE: In order 
to be able to research this 
individual’s ancestors, 
this individual must be 
deceased. 

Step 6 

Click the icon for the 
family history website 
you wish to search.  By 
holding the arrow over 
each icon, you will see 
what website it 
represents.  It is 
recommended that you 
visit the websites in the 
order listed.  The first 
one is FamilySearch. 

 



Step 7 

On each website, search 
all of the resources 
available.  
IMPORTANT:  
Whenever there is an 
option to “Refine” your 
search, do so!  This 
allows you to be as 
specific in your research 
as your information 
allows you to be. 

 

Step 8 Use the appropriate Family History Research Forms to keep track of where you have 
researched and what you have found 

 
 
 



Appendix I 
Overview of FamilySearcher 

 
  

FamilySearcher is a Windows program that reads a GEDCOM file and presents a list of 
names found in a spreadsheet format.  A name can then be selected for easy lookup on 
the FamilySearch™ Internet web site.  This program was originally written to facilitate 
rapid name lookups on the International Genealogical Index (IIGI).  It can also be used to 
search the other resources (Ancestral File, Pedigree Resource File, Census etc.) at the 
FamilySearch™ web site.  When launched, the FamilySearcher program always starts a 
companion Internet Explorer window to display the results of requested searches.  The 
initial Internet Explorer window displays the FamilySearch™ login screen.  LDS family 
historians can use this login screen to request access to Temple ordinance dates on the 
International Genealogical Index.  In some cases a security warning may be displayed 
with the text “You are about to be redirected to a connection that is not secure” after 
entering the login and password information.  Please respond with “Yes” when asked if 
you wish to continue.  Those not interested in finding LDS ordinance dates can ignore 
this initial FamilySearch™ login screen. 

 
For those interested in identifying completed LDS ordinance information and adding it to 
their PAF data file – this program can generate an Ordinance Update File that can be 
imported into PAF.   
 
The FamilySearcher program is named such because it is a tool especially designed to 
search the resources of the FamilySearch™ web site.  It is also capable of searching 
several other Internet genealogical web sites including Ancestry.com, Rootsweb.com, 
EllisIsland.org etc. 
 
FamilySearcher was written to work with any Genealogy Program such as PAF, Legacy, 
Family Tree Maker etc.  The use of the GEDCOM file as input rather than some other file 
format makes this program available to all Family Historians who have entered some 
number of names into their genealogy software program.  GEDCOM stands for 
Genealogical Data Communication and is a text file format that is supported by all 
modern genealogy programs. 

 
      B. When to use FamilySearcher  
 

This program was inspired by the “Search on FamilySearch™ Internet” menu 
selection available when using Personal Ancestral File.  This menu selection initiates a 
general search across all time periods and resources at www.familysearch.org for the 
currently highlighted name.  This kind of semi-automated search is extremely helpful – 
but requires many mouse clicks to refine the search to just search one selected 
computer file – such as the IGI.  FamilySearcher saves time by only searching the 
selected resource and automatically enters the date and place which saves time by 
initially narrowing the search results to just a few entries.  When no matching entry is 
found – it is often wise to expand the year range and possibly the location in order to find 
a desired entry. 
 
Here are the most common uses for this program: 
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1) Generate a GEDCOM file from PAF (or other genealogy program) including the 

names of individuals that you would like to search for on the FamilySearch™ web 
site.  An example use would be to generate a GEDCOM file for any incomplete LDS 
ordinances in your database.  The resulting GEDCOM file can then be used as input 
to FamilySearcher.  Any matching entries can then be copied, typed or imported 
back into your PAF (or other) genealogy program.  A description of how to create a 
GEDCOM file from PAF 5 is included below. 

2) Generate a GEDCOM file from PAF (or other genealogy program) including the 
names of individuals with any ordinances that are listed as “CLEARED”.  Use the 
resulting GEDCOM file as input to FamilySearcher and search the Internet IGI for 
possible matching entries.  Copy any matching search results back into your 
genealogical program using an Ordinance Update (OUP) file. 

3) Check a Temple Ready diskette for any "already completed" ordinances.  This 
avoids duplication of LDS ordinances and saves time performing the name lookups.  
FamilySearcher can read any GEDCOM file including those created by Temple 
Ready which typically have a filename ending in SUB. 

4) Use FamilySearcher to systematically search the six resources (Pedigree Resource 
File, Ancestral File, Census, IGI, etc.) found on the Family Search web site. 

5) Use FamilySearcher to systematically search the resources of one of the other 
supported web sites – such as the Census records at Ancestry.com based on the 
names in a GEDCOM file. 

6) Use FamilySearcher to view the contents of any GEDCOM file that you may have 
around and wondered about whether to keep or toss.  The "File", "Properties" menu 
selection in FamilySearcher can give some details on an open GEDCOM file that 
can be helpful. 

7) Search the Family History Library catalog for either a Surname or Locality using the 
data in you GEDCOM file. 

 
      C. Minimum System Requirements  

 
Operating System: Windows 98/Me/NT/2000/XP  
Computer CPU: 300 Mhz or faster.  
RAM: 64 MB or higher  
Hard Disk Space: 5 MB  
CD-ROM drive: Not required  
Video Display: 800x600 resolution or higher 
 
NOTE: The AOL web browser is not supported by FamilySearcher – nor is the Netscape 
browser. 

 
 II. Search Functions and their description  
 
     A. Search For Birth or Christening Event on FamilySearch™ Internet 

 
The program includes four lookup or search capabilities that can be used with the names 
in your GEDCOM file to search the FamilySearch™ web site. The first search function 
titled "FamilySearch – Birth/Chr" provides genealogists with the ability to quickly access 
the Internet IGI or any of the additional databases provided.  Each of the three searches 



provided under the “search” menu has a corresponding toolbar icon.  This search can be 
activated by using the Search menu selection, tool bar icon or by double-clicking on the 
highlighted name – a query is then made on the IIGI, or selected resource, for the 
selected name.  This avoids having to type in the name and date.  It also automatically 
selects the correct region and time period range. 
 
The program default, when first invoked, is to search the Internet IGI – but the toolbar 
pull-down list can be used to select any of the other resources available at the 
FamilySearch™ web site.  In addition to the FamilySearch web site – it is also possible to 
perform a Birth/Chr search on Ancestry.com and Rootsweb.com.. 

 
     B. Search For Marriage Event on FamilySearch™ Internet   

 
The second function performs a similar lookup on the IIGI, or selected resource, but this 
time narrows the search for marriage entries only.  This search function is titled " 
FamilySearch – Marriage".  When searching the U.S. Social Security Death Index or 
the Census – this search will substitute the husbands surname for married females. 

 
     C. Search For Children of this Couple on FamilySearch™ Internet   

 
This third search function performs a lookup on the IIGI, or selected resource, for any 
children of the highlighted couple.  This search function is titled " FamilySearch – 
Children".  When searching the U.S. Social Security Death Index or the Census.  This 
search will grayed out and unavailable for certain databases and may be replaced by a 
Death search icon where applicable. 

 
     D. Search For Any Event on FamilySearch™ Internet   

 
The third search performs a similar lookup on the IIGI, or selected resource, but this time 
searches for any matching name without regard to time period or event type.  This 
search function is titled " FamilySearch  – General" 
 
 

     E. Search For Any Event on www.familysearch.org  
 
The three remaining searches are provided for convenience in performing a general 
(name only) search on several key web sites.  This particular search is titled " 
FamilySearch – General" and will search all resources including Ancestral File, 
Pedigree Resource File, Census records etc. 
 
 

     F. Search For Any Event on Ancestry.com        
This search function is titled "Ancestry.com – General" and performs a general (name 
only) search. 

 
     G. Search For Any Event on Rootsweb.com  

 
This search function is titled "Rootsweb.com – General" and performs a general (name 
only) search. 
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     H. Search For Any Event on EllisIsland.org   

 
This search function is titled "EllisIsland.org – Arrivals" and performs a general (name 
only) search for arrival events. 

 
     I. Search For Death Events on Cwgc.org   

 
This search function is titled "Commonwealth War Graves – Deaths" and performs a 
general (name only) search for death events. 

 
     J. Search For Any Event using Miscellaneous Australian Resources (web sites)   

 
This search function is titled "Australian Resources” and performs a name search for 
Perth W.A. Cemeteries. 

 
     K. Search For Information using the Family History Library Catalog on FamilySearch.org   

 
This search function is titled "FamilySearch.org Family History Library Catalog" and 
performs a locality search using the birth locality of the highlighted individual. 

 
     L. Summary of Available Search Types   

 
FamilySearcher provides four searches that can be used to access the six genealogical 
databases found on www.familysearch.org, the eight genealogical resources available 
on www.ancestry.com and the three genealogical databases found at 
www.rootsweb.com.   The table below summarizes the types of searches that can be 
performed and the FamilySearch™ resources or databases that can be queried. The 
Individual Search has a corresponding icon on the tool bar that looks like the silhouette 
of a person. The Marriage Search has a corresponding tool bar icon that looks like the 
silhouette of a couple. The Children Search looks like the silhouette of a couple with a 
small child standing next to them. The General Search has a corresponding tool bar icon 
that looks like an eye. 

 
Resource Individual Marriage Children General 
Ancestral File Birth/Chr Marriage Children Any Event, 

All Time 
International Genealogical 
Index (IGI) 

Birth/Chr Marriage Children Any Event, 
All Time 

Pedigree Resource File Birth/Chr Marriage Children Any Event, 
All Time 

U.S. Social Security Death 
Index 

Birth Male – Birth  
Female – Birth Using 
Married Surname 

Death Any Event, 
All Time 

Vital Records Index Birth/Chr Marriage Children Any Event, 
All Time 

Census Birth Male – Birth  
Female – Birth Using 
Married Surname 

N/A Any Event, 
All Time 
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Ancestry World Tree Birth/Chr Marriage Children Any Event, 
All Time 

Birth, Marriage & Death Birth Marriage Death Any Event, 
All Time 

Immigration N/A N/A N/A Any Event, 
All Time 

Military N/A N/A N/A Any Event, 
All Time 

U.K. FreeBMD Birth Marriage Death Any Event, 
All Time 

U.K. Census Birth Male – Birth  
Female – Birth Using 
Married Surname 

N/A Any Event, 
All Time 

U.S. Census Birth Male – Birth  
Female – Birth Using 
Married Surname 

N/A Any Event, 
All Time 

U.S. Social Security Death 
Index 

Birth Male – Birth  
Female – Birth Using 
Married Surname 

Death Any Event, 
All Time 

World Connect Birth Marriage Children Any Event, 
All Time 

U.S. Social Security Death 
Index 

Birth Male – Birth  
Female – Birth Using 
Married Surname 

Death Any Event, 
All Time 

Rootsweb Surname List N/A N/A N/A Any Event, 
All Time 

Ellis Island U.S. 
Immigration Records 

N/A N/A N/A N/A 

Commonwealth War 
Graves Commision 

N/A N/A N/A N/A 

Perth Western Australia - 
Cemeteries 

Birth Name Married Name Surname Married 
Surname 

Fremantle Western 
Australia - Cemetery 

Birth Name Married Name Surname Married 
Surname 

Family History Library 
Catalog – Locality 

Birth 
Locality 

Birth Locality – 
search 2 

Marriage Marriage 
Locality 

Family History Library 
Catalog – Surname 

Birth 
Surname 

Married Surname N/A N/A 

 
The U.S. Social Security Death Index and the Census records do not support any kind of 
Marriage Search. FamilySearcher uses the Marriage Search menu selection and tool bar 
icon for these resources to initiate a “Birth Event” search for a male (the same as an 
Individual Search) – and to initiate a “Birth Event” search but with the married surname 
for a female. Since married females are often listed in these records using their married 
surname – this kind of Marriage Search is more likely to find a matching entry than an 
Individual Search using the maiden surname.  When a given search type does not apply 
– its corresponding toolbar icon and menu entry is grayed out to indicate that it is 
unavailable. 



 
The “Search for Children of this Couple” menu selection will look for a birth or christening 
event for any individual that has parents that match the highlighted couple.   In some 
cases the toolbar icon and menu selection that is normally used for this kind of a search 
will change to represent a search for a matching death entry.   
 
The Ellis Island and Commonwealth War Graves web sites do not support any more 
detailed searching and for this reason there is no pull-down list of additional resources to 
search for these sites. 
 
The list of Australian Resources that can be searched will likely grow over time but is 
limited in this release to the two localities listed. 
 
The Family History Library Catalog is now available for searching based on information 
in the GEDCOM file.   

 
III. Navigating the Menus  
 
     A. File
 

Open – Used to select a GEDCOM file to be opened by FamilySearcher. 
Close – Close the current GEDCOM file and clear the spreadsheet.  Only available if a 
file is currently open. 
Properties – Display statistics on the currently open GEDCOM file. 
View Raw GEDCOM File – Use this menu item to initiate viewing of the currently open 
GEDCOM file. 
Save Ordinance Update (OUP) File – Use this menu item to save all ordinance updates 
to an OUP file. 
Recent Files – Lists up to four of the most recently accessed GEDCOM files.  Click on a 
file name to reopen a file. 
Exit – This menu selection is used to select a GEDCOM file to be opened by 
FamilySearcher. 

 
     B. View 
 

Toolbar – Click here to toggle display of the toolbar. 
Status Bar – This selection toggles display of the Status Bar at the bottom of the 
FamilySearcher screen. 
Text Size – Selects a text size that is comfortable for a given display resolution. 
Split Screen – This setting can be used to select a preferred way to arrange the 
FamilySearcher window and its companion Internet Explorer window. 
View Family Details – Use this menu item to view detailed family information on the 
currently highlighted individual. 
 

     C. Search 
 

Family Search IGI Birth/Chr – Performs a resource-specific query based on the Birth or 
Christening information of the currently highlighted individual. 



Family Search IGI Marriage – Performs a resource-specific query based on the Marriage 
information of the currently highlighted individual. 
Family Search IGI Children of this Couple – Performs a resource-specific query based 
on the name information of the currently highlighted couple. 
Family Search IGI General – Performs a resource-specific query based on the name 
information of the currently highlighted individual. 
Search Resource – Used to select the specific FamilySearch™ resource to be searched.  
The next three searches are altered based on this setting.  The default is to search the 
IGI.  As this setting is changed the title for the three search types will also change to 
reflect the selected resource. 
Family Search General – Performs an all resource query based on the name information 
of the currently highlighted individual. 
Ancestry.com General – Performs an all resource query on the Ancestry.com web site 
based on the name information of the currently highlighted individual. 
Rootsweb.com General – Performs an all resource query on the Rootsweb.com web site 
based on the name information of the currently highlighted individual. 
EllisIsland.org Arrivals – Performs an all resource query on the EllisIsland.org web site 
based on the name information of the currently highlighted individual. 
Cwgc.org Deaths – Performs a query on the Cwgc.org web site based on the name 
information of the currently highlighted individual.  This is the Commonwealth War Graves 
Commission and includes the names of deceased soldiers who fought in World War I and 
II from any of the British Commonwealth Countries. 
Australian Resources – Performs a query on the Perth, Western Australia Cemeteries 
web site based on the name information of the currently highlighted individual. 
FamilySearch.org Family History Library Catalog – Performs a Locality search using 
the Family History Library Catalog on the FamilySearch.org web site based on the birth 
location information of the currently highlighted individual. 
 

     D. Tools 
 

Login to FamilySearch.org – Click here to display the FamilySearch™ login screen in 
the Internet Explorer window.  Depending on the security settings of Internet Explorer – 
the message “You are about to be directed to a site that is not secure” may be displayed.  
This message is an artifact of the remote control scheme that FamilySearcher uses to 
control the browser window and can be ignored.  Please click the “Yes” button when 
asked it you would like to continue. 
Search Options – This selection displays a dialog box which determines the date range 
and place settings for subsequent searches. 
Configure Double-Click Action – This selection allows the user to decide which kind of 
search will be initiated when a double-click is detected. 
Name Tagging – This selection allows the user to “tag” or highlight selected name entries 
in order to remember and record which names have already been searched.  The 
keyboard shortcut for this menu selection is to “shift-click” on a given name in the 
FamilySearcher window.  When names are tagged this information is saved in an “FSR” 
file in the same directory and with the same name as the GEDCOM file.   
Clear Most Recently Used File List – This selection will erase the list of recently opened 
files found under the File menu. 
Launch Personal Ancestral File 5 – Click here to launch PAF 5 (if installed). 
 



     E. Help 
 

Help – Click here to display this help file. 
FamilySearcher Web Site – Click here to visit the FamilySearcher web site. 
Check For Newer Version – Click here to check if a newer version of FamilySearcher is 
available for download. 
About – Displays a brief description of the purpose of this program along with version 
information. 

 
IV. Using the Toolbar  
 
     A. Open File
 

Click on this icon to select a GEDCOM file to load.  The data file can reside on a floppy 
disk, zip disk, CD-ROM, local hard disk or network drive. 

 
     B. Sort Ascending  
 

Clicking on this icon will sort the displayed names in ascending alphabetical order.  It is 
also possible to click on the column heading to initiate a sort. 

 
     C. Sort Descending 
 

Clicking on this icon will sort the displayed names in descending alphabetical order.  It is 
also possible to click on the column heading to initiate a sort. 

 
 
     D. Display Family Details

 
Click on this icon to view additional family details regarding the currently highlighted 
individual.  It is also possible to click on the ID number for a given individual to display this 
same Family Details display window. 

 
     E. Toggle Name Tag

 
Click on this icon to tag the currently highlighted individual.  The ID number will be 
displayed with a green background.  This is a shortcut for using the Tools  menu and 
selecting “Toggle Name Tag”.  These name tags are saved when the program exits and 
are restored when a GEDCOM file is loaded.   

 
     F. Individual Search

 
Click on this icon to initiate a name search based on the birth or christening date and 
place of the highlighted individual.  The Internet resource to be searched is determined 
based on the setting displayed on the tool bar.  

 
     G. Marriage Search  
 



Click on this icon to initiate a name search based on the marriage date and place of the 
highlighted individual.  The Internet resource to be searched is determined based on the 
setting displayed on the tool bar. 

 
     H. Children of this Couple Search  
 

Click on this icon to initiate a birth/chr search for children of the couple currently 
highlighted.  The Internet resource to be searched is determined based on the setting 
displayed on the tool bar. 

 
     I. General Search 
 

Click on this icon to initiate a general name search (any date or place) of the highlighted 
individual.  The Internet resource to be searched is determined based on the setting 
displayed on the tool bar. 

 
     J. Select Resource
 

This pull-down list offers a selection of Internet resources that can be searched.  Each of 
the six resources available at the FamilySearch™ web site are available in this pull-down 
list as follows: 
 
FamilySearch Resource Description 
Ancestral File A computer file containing names and often other vital 

information (such as date and place of birth, marriage, or 
death) of millions of individuals who have lived throughout 
the world. Names are organized into family groups and 
pedigrees. To allow for coordination of research, the file 
also lists names and addresses of those who contributed 
to the file. 

International Genealogical 
Index (IGI) 

The International Genealogical Index is one of the world’s 
largest collections of genealogical records. Information 
comes from individual research and original records. The 
majority of the names are from records of people who 
lived between 1500 and 1885. Other records have been 
submitted by members of The Church of Jesus Christ of 
Latter-day Saints. The index contains: Names of millions 
of deceased persons from throughout the world.  
And Dates and places of births, christenings, marriages, 
and other events. 

Pedigree Resource File The Pedigree Resource File is a growing database of 
lineage-linked names submitted by users of the 
FamilySearch™ Internet Genealogy Service. 

U.S. Social Security Death 
Index 

A computer file that contains records of deaths reported to 
the United States Social Security Administration. Most 
records start in 1962, but the file does contain a few 
records of deaths that happened before that date. 

Vital Records Index The Vital Records Index contains information from birth, 
christening, and marriage records from Scandinavia (3.6 



million names) and Mexico (1.9 million names).   
Census The 1880 U.S. (50 million names), 1881 Canadian (4.3 

million names) and 1881 British Census records (30 
million names) include a complete transcription of these 
original census records as well as a national index.  It 
includes the enumeration of individuals within households 
and institutions, which allows viewing those who were 
neighbors of listed families and individuals.  

 
Each of the resources available at the Ancestry.com web site are available in this pull-
down list as follows: 
 
Ancestry.com Resource Description 
Ancestral World Tree A computer file containing names and often other vital 

information (such as date and place of birth, marriage, or 
death) of over 200 million of individuals who have lived 
throughout the world. The names found here come from 
GEDCOM files that have been submitted to 
Ancestry.com.    

Birth, Marriage & Death This is a broad category of records that includes birth, 
marriage and death records from selected localities in 
North America and the United Kingdom.  In some cases 
this collection of information includes christening and 
burial details. 

Immigration A collection of transcribed immigration records mostly for 
North America. 

Military A collection of transcribed military and military pension 
records mostly for North America. 

Name Dictionary Discover the meaning and origin of both first and last 
names. 

PERSI – Periodical Source 
Index 

The largest and most widely-used subject index covering 
genealogy and local history periodicals written in English 
and French (Canada). The collection dates from 
approximately 1800. There are currently over 1.7 million 
searchable records and nearly 6,000 different periodicals, 
which library staffers at the Allen County Public Library 
have been compiling for over a decade. PERSI is widely 
recognized as essential for high-quality genealogy 
research. 

U.K. FreeBMD A transcribed index to the birth, marriage and death 
records of England – starting in 1837 up to the present.  
This information is being transcribed by volunteers and is 
only partially complete at this time.   

U.K. Census The 1891 census of England contains over 40 million 
names and was taken on 5 Apr 1891.  This indexed and 
fully transcribed collection of names also includes access 
to the scanned images of the original census books. 

U.S. Census Census images including an index for the U.S. Federal 
decennial census starting in 1790 up through 1930. 
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U.S. Social Security Death 
Index 

A computer file that contains records of deaths reported to 
the United States Social Security Administration. Most 
records start in 1962, but the file does contain a few 
records of deaths that happened before that date. 

 
Each of the resources available at the Rootsweb.com web site are available in this pull-
down list as follows: 
 
Rootsweb.com Resource Description 
World Connect A collection of lineage-linked GEDCOM files that have 

been submitted to Rootsweb.com. 
U.S. Social Security Death 
Index 

A computer file that contains records of deaths reported 
to the United States Social Security Administration. Most 
records start in 1962, but the file does contain a few 
records of deaths that happened before that date.  This 
resource on Rootsweb is of particular value because it 
can print out a letter that can be used to request the 
original SS-5 application form. 

Rootsweb Surname List A message board that can be used to contact other 
researchers that are following the same family lines.  E-
mail addresses are included.   

 
The EllisIsland.org web site contains an indexed list of passenger arrivals at the port of 
New York between 1892 and 1924.  In this time period, more than 22 million immigrants, 
passengers, and crew members came through Ellis Island and the Port of New York. The 
ship companies that transported these passengers kept detailed passenger lists, called 
"ship manifests."  Images of these original documents are available for on-line viewing.  It 
is also possible in most cases to view an image of the ship.   
 
No pull-down menu is provided for this web resource as only a General search is 
available and there is only one resource at this site. 

 
The Cwgc.org web site contains an indexed list of soldiers that died in World War I and 
World War II that were associated with the British Commonwealth of Nations.     
 
No pull-down menu is provided for this web resource as only a General search is 
available and there is only one resource at this site. 
 
Each of the resources available from the Australian Resources web sites are available in 
this pull-down list as follows: 
 
Australian Resources Description 
Perth, Western Australia 
Cemeteries 

This web site maintained by the Perth, Western Australia, 
Metropolitan Cemeteries Board contains burial information 
on the following cemeteries: Karrakatta Cemetery, 
Pinnaroo Valley Memorial Park, Midland Cemetery and 
Guildford Cemetery.  The information on this web site is 
updated daily. 

Fremantle, Western A computer file containing records of those persons buried 

http://rootsweb.com/


Australia Cemetery at the Fremantle, Western Australia Cemetery. 
 
Each of the resources available from the Family History Library Catalog web site are 
available in this pull-down list as follows: 
 
FHLC Resources Description 
Locality Search A complete catalog of the holdings of the Family History 

Library Catalog in Salt Lake City, Utah.  Information on 
many localities in the world are included here.  Most 
microfilms and microfiche can be circulated (loaned) to a 
local LDS Family History Center. 

Surname Search An index of all books, microfilms and microfiche that cover 
a given surname held at the Family History Library in Salt 
Lake City, Utah.  Most microfilms and microfiche can be 
circulated (loaned) to a local LDS Family History Center. 

 
     K. FamilySearch.org Search – Any Event
 

This toolbar icon can be used to initiate a general (name only, any event) search at the 
FamilySearch™ web site. 

 
     L. Ancestry.com Search – Any Event
 

This toolbar icon can be used to initiate a general (name only, any event) search at the 
Ancestry.com web site. 

 
     M. Rootsweb.com Search – Any Event
 

This toolbar icon can be used to initiate a general (name only, any event) search at the 
Rootsweb.com web site. 

 
     N. EllisIsland.org Search – Any Event
 

This toolbar icon can be used to initiate a passenger arrival search at the EllisIsland.org 
web site. 

 
     O. Commonwealth War Graves Search – Death and Burial Events 
 

This toolbar icon can be used to initiate a death and burial search at the Cwgc.org web 
site. 

 
     P. Australian Resources Search – Any Event
 

This toolbar icon can be used to initiate a burial search at the www.mcb.wa.gov.au web 
site. 

 
     Q. Family History Library Catalog Search – Locality and Surname 
 

http://www.mcb.wa.gov.au/


This toolbar icon can be used to initiate a Family History Library Catalog search at the 
FamilySearch.org web site. 

 
V. Program Options  
 
     A. Viewing Options 
 

When using this program at lower screen resolutions – it may be desirable to use the 
“View” menu selection to inhibit display of the toolbar and/or status bar.  In most cases 
these bars provide useful information and functionality and the user will want to leave 
these displayed.  This setting is not saved between invocations of this program. 
 
The displayed text size can also be altered using the “View” menu item.  Changing this 
selection is a personal preference and is provided so as to allow for most comfortable 
viewing of data.  The selected text size is saved each time the program exits for use the 
next time the program is invoked. 
 
The “View” menu item allows the user to decide how best to display the two windows 
used by FamilySearcher.  Most will prefer to split the screen horizontally or vertically – but 
some may also prefer viewing two overlapping (no split) windows.  When the “no split” 
option is selected the FamilySearcher program will attempt to bring the Internet Explorer 
window forward as each search is completed.  This setting is saved each time the 
program exits for use the next time the program is invoked. 
 

     B. Search Options
 

When searching the Internet IGI the FamilySearcher program will auto select the region 
based on the place name provided in the GEDCOM file.  If there is insufficient place name 
information entered in the GEDCOM file – it may be desirable to manually select the 
region to be used.  Use the “Tools”, “Search Options…” menu selection to manually select 
the desired region.  Once a new region is selected – the “Auto Select” radio button will 
instruct the program to use this new selection only if it cannot automatically determine the 
region.  The “Manual Select” radio button setting instructs the program to ignore any 
automatically determined region to be replaced by the manual setting.  The “Manual 
Select” setting can be used to check, for example, the World Miscellaneous region for a 
name that would normally appear in the North America region. 
 
When searching any of the FamilySearch™ resources the default year range used is plus 
or minus one year.  The “Tools”, “Search Options…” menu selection can be used to 
change this default behavior to search over a larger year range.  The selected year range 
will be used for all subsequent searches.   It is also possible to use the “Refine Search” 
link displayed in the upper right-hand corner of the Internet Explorer window after an initial 
search has been completed.  In this way a name search can be expanded across a larger 
time period. 
 

     C. Sorting Options 
 

In addition to the toolbar icons provided to sort the names found in a GEDCOM file – it is 
also possible to click on the heading of any of the spreadsheet columns to request that 



the data be sorted based on the data in that column.  The first click on a column heading 
will initiate an alphabetic ascending sort.  The next click will initiate an alphabetic 
descending sort.  The sorting of dates is done alphabetically is currently not very useful.  
To return the data to its original GEDCOM order – simply click on the heading of the “ID 
#” column. 

 
VI. Program Installation  
 
     A. FamilySearcher Internet Web Site 
 

The FamilySearcher web site can be used to download the latest version of the program.  
The URL for this web site is: http://myweb.cableone.net/kevinowen3/FamilySearcher.htm

 
VII. Disclaimers  
 
     A. Use Sound Research Practices 
 

It is important to remember that finding a matching name on the FamilySearch™ web site 
(or any other web site) does not prove that such a person existed – nor does it prove a 
relationship to your family tree.  Sound research practices should always be used to verify 
the source of information and to prove a family connection. 
 
The LDS family historian is encouraged to follow these steps: 
 
1) Enter your name information into Personal Ancestral File or other genealogical 

software program. 
2) Document the sources used to confirm the accuracy of names, dates and places 

contained in your data. 
3) Use the Temple Ready – “Update My Records” capability available at your nearest 

Family History Center.  This will find many, but not all, of the already completed LDS 
ordinance entries up to January of 2000 (The most recent release of the 
FamilySearch™ Addendum CDs for Family History Centers).   

4) Use the Internet IGI to lookup any persons with incomplete Temple ordinances.  This 
will catch any recently completed ordinances – as well as any entries missed by the 
automated “Update My Records” step described above.  Matching LDS ordinance data 
found using this step can then be copied or printed out and entered into your PAF or 
other genealogical program. 

5) Run Temple Ready at your nearest Family History Center on small groups of names 
that have been individually checked to clear them for LDS Temple ordinances and 
take the resulting diskette to your nearest Temple. 

 
The FamilySearcher program can help with step #4 but the remaining steps are also 
required in order to ensure accurate and correct information is recorded in your records.  
It is important that each of the above steps be followed in order to avoid duplication of 
LDS Temple ordinances.  FamilySearcher should not be used as a substitute for sound 
research practices. 
 

     B. Handling Large GEDCOM Files using FamilySearcher 
 

http://myweb.cableone.net/kevinowen3/FamilySearcher.htm


The FamilySearcher program was designed to handle small to medium sized GEDCOM 
files.  Large GEDCOM files in excess of about 3000 names have the potential of 
exhausting the memory and slowing down the performance of even the most modern 
Personal Computer.  FamilySearcher was designed with the intent of dealing with smaller 
files and optimizations have not been included to handle large files.  Please consider 
splitting your GEDCOM files into small enough groups so as to obtain best program 
performance.  FamilySearcher will generate a warning message when an attempt is made 
to open a large GEDCOM file.  Please be advised that your computer may lock-up and 
need to be rebooted if the GEDCOM file size exceeds the capabilities of your computer.  
The use of large GEDCOM files with this program is not advised and is done at your own 
risk. 
 

     C. Use of this Program 
 

FamilySearcher – License 
Copyright © 2003-2004 K. A. Owen 
 
This program is provided free of charge and may be freely distributed in its original form, 
with all files intact and unmodified.  No charge may be made except to cover the nominal 
cost of media.  It is provided as a finding tool to provide rapid access to the resources of 
the FamilySearch™ web site as well as other important genealogical Internet resources.  
FamilySearcher is provided “as is” and the author makes no warranty as to fitness for 
purpose whatsoever and accepts no responsibility for any losses incurred by using this 
software howsoever caused.  The FamilySearcher program is not affiliated with the 
FamilySearch™ web site other than as a user of the data contained there. 
 

VIII. Other Information 
 
     A. Details about this program 
 

This program was written in Visual Basic 6.0.  The Help file was created using Microsoft 
Word with the result being saved in HTML format.   
 
Please send comments, suggestions and any bug reports to: 
FamilySearcher@cableone.net   If possible – please attach a copy of the GEDCOM file 
that illustrates the problem.  Your suggestions will help make this a better program. 

 
     B. How to transfer matching LDS Ordinance information from FamilySearcher to Personal 
Ancestral File 
 

When a matching IGI entry is being displayed in the Internet Explorer browser window – 
simply click on the toolbar icon of the magnifying glass.  This will display the Family Details 
for the highlighted individual along side the IGI information.  Place a checkmark next to 
each ordinance date that is needed and click on the Update button.   The selected 
ordinance information will be displayed in red text.  Next click on the OK button to accept 
these update.  Repeat this update procedure for as many names as desired.  
FamilySearcher will tag each updated record by marking the ID number in the color green.  
This creates a visual indication that this name has been updated. 
 

mailto:FamilySearcher@cableone.net


Go to the File menu and select “Save Ordinance Update (OUP) File”.  Choose a name for 
the OUP file to be saved or accept the default by clicking on OK.   
 
Load up your family data into Personal Ancestral File and go to the File menu and select 
“Add TempleReady Update…”.  Select the OUP file created in the steps above and click 
on OK.  The ordinance information will be added to your PAF file.  Note that the OUP file 
created by FamilySearcher looks to PAF as if you had used the Update My Records 
capability of TempleReady. 

 
     C. How to Alter the File Name Association Between FamilySearcher and GEDCOM Files 
 

When FamilySearcher is installed it assumes that whenever you double click on a 
GEDCOM file that you want to load the file into FamilySearcher.  The same applies when a 
GEDCOM file is downloaded from the Internet - your computer assumes that 
FamilySearcher is the application to launch.  This may not be what you expect or desire. 
  
This is referred to as "file name association".  Each program that is installed registers a list 
of file name extensions that will automatically launch when double-clicked.  For example, 
when Personal Ancestral File is first installed it registers ".GED" as a file name extension 
that it recognizes.  When FamilySearcher is installed it overwrites this association and 
indicates to the Windows operating system that any GEDCOM file should be treated as 
being a FamilySearcher file.  Windows does not allow more than one file association to be 
active at one time. 
 
Here are two easy steps that can be taken to alter this behavior or file name association.  
Lets assume that you would like to associate all GEDCOM files with Personal Ancestral 
File: 
 
a) Decide As You Go - From Windows Explorer - highlight the GEDCOM file that you 
would like to open with PAF.  Right click and a new pop-up menu will appear.  Select 
"Open With..." and then choose "Personal Ancestral File".  This allows you to open a 
GEDCOM file with any desired program.  This technique works from Windows Explorer but 
not when doing an Internet GEDCOM file download. 
 
b) Set a Permanent File Association - If you would prefer that the default double-click 
action be restored permanently to Personal Ancestral File or some other genealogical 
software program then - from Windows Explorer - highlight any GEDCOM file and right 
click.  Select "Choose another program".  Scroll through the list of available programs until 
you find Personal Ancestral File.  Place a check mark in the box "Always use the selected 
program to open this kind of file".  Then click on OK. This will permanently change the file 
association back to PAF (or other program that you select).   This technique will allow 
future Internet downloads of GEDCOM files to launch PAF rather than FamilySearcher. 
 
The above instructions work with Windows XP - and should be similar on earlier versions 
of Windows.  

 
     D. How to Create a GEDCOM File From PAF 5 
 



The following steps can be used with Personal Ancestral File version 5 to generate a 
GEDCOM file containing the names of all individuals that are missing at least one LDS 
ordinance.   
 
1) Launch Personal Ancestral File and load your PAF file 
2) Select the menu item: "File", "Export..." 
3) Use the following settings for the "Export" dialog box 

• Export to: PAF 5 
• Include: Uncheck all boxes 
• Selected Individuals: Partial 
Click on the "Select" button 

4) Use the following settings for the "Select Individuals" dialog box 
• Field Filter: Press the "Define" button 

5) Use the following settings for the "Field Filtering" dialog box 
• Possible Fields: Qualifies for Baptism 
• Press the ">" button 
• Select “is” and then click OK 

6) Next add the OR operator as follows 
• Press the "OR" button 

7) Now add another condition on which to filter 
• Possible Fields: Qualifies for Sealing to Parents 
• Press the ">" button 
• Select “is” and then click OK 

8) Next add the OR operator as follows 
• Press the "OR" button 

9) Now add another condition on which to filter 
• Possible Fields: Qualifies for Sealing to Spouse 
• Press the ">" button 
• Select “is” and then click OK 

10) Click the "OK" button on the "Field Filtering" dialog box 
11) Click the "OK" button on the "Select Individuals" dialog box 
12) Click the "Export" button on the "Export" dialog box 
13) In the "File name" field of the "Export GEDCOM File As" dialog box enter a 

meaningful file name.  Example: IncOrd.ged 
14) Click on the "Export" button on the "Export GEDCOM File As" dialog box 
15) Once the export is complete - click on the "OK" button on the "GEDCOM Export" 

dialog box 
 

The resulting GEDCOM file can now be used as input to FamilySearcher. 
 
 


